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GENERAL INFORMATION 
Purpose These Release Notes are to inform PeopleSoft Financials technical staff and 

functional users of the scheduled 2.30 release of BOR functional 
application enhancements. 

NOTE: These Release Notes and other accompanying documentation for 
this release can be found on the GeorgiaFIRST web site at: 
http://www.usg.edu/gafirst-fin/release_info/. 

Known Issues  • Resolutions to the following Known Issues have been included in this 
release: 
 KI8140 

• Details on this Known Issue can be found on the GeorgiaFIRST web 
site at: http://www.usg.edu/gafirst-fin/known_issues/. 

TECHNICAL IMPACT 

Database The F89PRD Production Transaction database will be shut down for the 
normal maintenance window at 11:00 pm on Friday, March 16, 2012, and 
will remain unavailable until 7:00 am on Sunday, March 18, 2012.  The 
F89PRD Production Transaction database will be ready for access at 7:00 
am on Sunday, March 18, 2012.   

• NOTE: The system cache may be cleared as part of the release 
process.  ITS recommends that all users clear their temporary internet 
files when logging back into the system.  Please be aware that the 
initial loading of pages may be slower than normal on the first business 
day after a release because of this.  It is highly recommended that all 
users clear their browser cache often, especially after an update is 
applied to the Production Transaction database. 

 

MODULE-SPECIFIC INFORMATION 

ADP RECONCILIATION PHASE I (PY) 

NEW BOR PROCESSES AND REPORTS 

ADP CES Detail 
Transactions 

 

Security: 
BOR_GL_PAY_ 
INTERFACE 

BOR Menus > BOR Payroll > Carrier Enrollment Accounting > ADP 
CES Detail Transactions 

This query shows the details from the CES Data Dump file. 
Run by Business Unit, by EmplID (put % to select all employees), by CES 
Month Begin Date. 

ADP RECONCILIATION PHASE II (PY) 

MODIFICATIONS TO EXISTING BOR PROCESSES AND REPORTS 

http://www.usg.edu/gafirst-fin/release_info/
http://www.usg.edu/gafirst-fin/known_issues/
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Retiree Benefit 
Accounting 

 
Security: 
BOR_ADP_RET_ 
BEN_ACCTG 

BOR Menus > BOR Payroll > Retiree Accounting > Retiree Benefits > 
Retiree Benefit Accounting 

This program is modified so that the numeric format will contain only two 
decimals before inserting the record into the HR_ACCTG_LINE table. 
Prior to the modifications, the program inserted the records with a 
monetary amount formatted with three decimals, causing discrepancies 
between PERS_SERV_BOR and HR_ACCTG_LINE, and issues with 
ledger data later in the accounting cycle.  This occurrence was typically 
caused by split job earnings distributions set up which was seen rarely for a 
retiree. 

ACCOUNTS RECEIVABLE (AR) 

PAGE CHANGES 

Add AR Payment 
Timing Terms to 
SHARE SetID 

 

Set Up Financials/Supply Chain > Product Related > Receivables > 
Payments > Payment Terms Timing  

A script was applied to add Accounts Receivable Payment Timing Terms to 
the ‘SHARE’ SetID. 

Add AR Payment 
Terms to SHARE SetID 

Set Up Financials/Supply Chain > Product Related > Receivables > 
Payments > Payment Terms   

A script was applied to add Accounts Receivable Payment Terms to the 
‘SHARE’ SetID. 

BUDGET PREP (BP) 

MODIFICATIONS TO EXISTING BOR PROCESSES AND REPORTS 

BORBU8HX  
(HR/PR to BP Load)  
 
BORBUDCP  
(Budget Copy) 
 
BORBU8FU 
(Fringe Estimate) 
 
BORBUILD  
(Build Financials) 
 
BORMU  
(Mass Update) 
 

The listed reports and processes were updated due to the addition of new 
pay groups in the ADP EV5 system.   
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BORBUDSJ  
(Sched J) 
 
BORBU8F2  
(Bud Prep Export for 
HR/Payroll) 
BORBUILD 
Build Financials 

The Build Financials process (BORBUILD) was modified to prevent users 
from re-running the BORBUILD process after the export has been run.  
This will keep Budget Prep information in the PeopleSoft Financials 
system in order to remain consistent with data that has been submitted to 
System Office.  

BORBUDSG1 
(Schedule G1) 

BOR Menus > BOR Budget Prep > Budget Prep Reports > Schedule 
G1 

The Schedule G1 has been updated to capture original budget information 
for employees whose funding had changed.  Previously, an employee 
whose funding or job code had changed was showing a zero for the original 
budget amount, even if the employee was still in the same position.   

BORBUDSG  
(Schedule G)  

BOR Menus > BOR Budget Prep > Budget Prep Reports > Schedule G 

Schedule G has been modified to optimize performance. 

PAGE CHANGES 

New Distrib Tab BOR  Menus > BOR Budget Prep > Budget Prep Data Update > 
Personal Services 

Functionality on the New Distrib tab has been modified to prevent the page 
from being saved when a zero percent row is present with the same account 
code information as an existing row.  This is being done because the Fringe 
Estimate process was ending in error when this condition was present. 

Ten new earnings codes will be available for budgeting purposes on the 
New Distrib tab:  

• VPF - Vacation Payout - Faculty (Acct 516101) 
• EXF -- Extra Pay - Faculty (Acct 516150) 
• SUF -- Supp Pay Ret Eligible-Faculty (Acct 516200) 
• SNF -- Supp Pay Non-Ret Elig-Faculty (Acct 516250) 
• SIF -- Industry Fdn Supplement – Fac (Acct 516300) 
• VPS -- Vacation Payout – Staff (Acct 526101) 
• EXS -- Extra Pay – Staff (Acct 526150) 
• SUS -- Supp Pay Ret Eligible – Staff (Acct 526200) 
• SNS -- Supp Pay Non-Ret Elig – Staff (Acct 526250) 
• SIS -- Industry Fdn Supplement-Staff (Acct 526300) 
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COMMON REMITTER PHASE 2 (CR) 

NEW BOR PROCESSES AND REPORTS 

Common Remitter BOR Menus > BOR Payroll > Common Remitter 

This project provides the central collection and processing of Retirement 
and TSA demographic data and contributions by SSC to one common 
vendor for all primary Providers.  In support of the CR process, an 
accounting solution is being provided which further enhances the service 
by creating standardized accounting practices for the business units.   Phase 
II includes the RET remittance and accounting functionality for ERS, TRS, 
and ORP Providers.   

Announcements for the Common Remitter processes and 
documentation will be available no later than March 31, 2012, with the 
first remittances beginning with the first bi-weekly payroll in April. 

Setup 
 

BOR Menus > BOR Payroll > Common Remitter > Setup > Retirement 
Setup 

• RET Provider Definition – contains the list of Participant 
Providers, the Benefit Plan, and Deduction Codes for each of the 
following: 
- ERS – Employees’ Retirement System 
- FID – Fidelity ORP 
- TIAA – TIAA-CREF ORP 
- TRS – Teachers Retirement System 
- VALI – VALIC ORP 

• Work Table Setup – maintenance for the view and functions for 
the RET Provider Adjustments page.  

• RET Liability – Acct/Fun Xref – list of RET Account and Fund 
Codes. 

• Error Codes – list of validation functions performed during the 
work table load process. 

Processes 
 

BOR Menus > BOR Payroll > Common Remitter > Processes > RET 
Processes 

• RET Provider Work Table Load – initial data load process. 
• Add Contribution Row –addition of contribution rows that do not 

exist in the initial data load process. 
• RET Provider Adjustments – correction of contribution rows that 

may have errors and were included in the initial data load process. 
• RET Provider Validation – process to validate newly added or 

adjusted contribution rows prior to final extract file creation. 
• RET Final Extract – remittance file creation. 
• Create RET Accounting Entries – populates HR_ACCTG_LINE 

and PERS_SERV_BOR tables with entry data 
• Generate RET Journal Entries – journal generation process. 

Inquiry BOR Menus > BOR Payroll > Common Remitter > Inquiry > RET 
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Provider Inquiry – Queries to support the RET processes 

• Work Table Reports – data populated by the RET Provider Work 
Table Load process. 
-   Work Table Errors 
-   Work Table Load Details 
-   Detail Results 
-   Ret Provider Summary Wrk Tbl 
-   Retirement Provider Variances 
-   Retirement Provider Variances Detail 
 

• History Table Reports – data populated by the RET Final Extract 
process. 
-  ERS Summary Report 
-  TRS Summary Report 
-  RET Provider Summary Hist Tbl 
-  History Table Load Details 
 

Security:  
User Setup and Roles 

 

The PeopleSoft Common Remitter Module User Setup and Roles job aid is 
available on the GeorgiaFIRST website at http://www.usg.edu/gafirst-
fin/documentation/job_aids/category/security 

CONCUR 

MODIFICATIONS TO EXISTING BOR PROCESSES AND REPORTS 

BORIF050 Concur to 
PeopleSoft Interface 

This Concur interface was modified to remove the hard coding for the GL 
accounts.  The interface will now pull the GL accounts from the Concur 
Business Unit table, PS_BOR_CONCUR_BU.  Only Business Unit 43000, 
Kennesaw State, has access to the Concur processes at this time.  

SpeedCharts for 
Concur 

This Concur process was modified to account for the effective dating being 
added to the Concur Business Unit table, PS_BOR_CONCUR_BU.  Only 
Business Unit 43000, Kennesaw State, has access to the Concur processes 
at this time. 

Updated the Concur 
Employee Profile Page 

 

Modified the Concur Employee Profile Page to look at the Max effective 
dated row on the Concur Business Unit page when pulling default business 
unit information.   

Employee Data Load 
 

Modified this program to pull the max effective dated row from BU page as 
well as to capture changes to employees from the ADP load.  This program 
was also modified to remove the hard coding of the OPRID field. 

ADP Load 
(BORADPINC) 

This program is responsible for loading ADP data into PeopleSoft 
Financials.  In release 2.20, this program was modified to put employee 
personal data changes into a record for Concur programs to use.  In this 
release, we removed that code and added it into the Employee Data load 
program instead. 

PAGE CHANGES 

http://www.usg.edu/gafirst-fin/documentation/job_aids/category/security
http://www.usg.edu/gafirst-fin/documentation/job_aids/category/security
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CONCUR BU Page 
(ITS use only) 

 

A new page was created for institutions going live on CONCUR that will 
store the default chart string information, default email, login suffix and 
inactive/active flags.  This page is populated currently by ITS only. 

EPROCUREMENT (EP) 

MODIFICATIONS TO EXISTING BOR PROCESSES AND REPORTS 

Catalog Vendors 
Deployed  
(BORSQPV) 

This report is for use by ITS SUPPORT only.  Therefore, there is no 
impact to Institutional users.   

Modifications to this report were to prevent overwriting of the Vendor 
Deployed and Last Activity columns.  Additional changes were made to 
print in a Landscape layout and printing column headers on every page of 
the report.  

QUERIES 

BOR_GFM_SECURITY  This new query is for use by: 

• Institutional Security Admins  
• ITS SUPPORT  

The query is designed to assist schools in quickly identifying terminated PS 
users that were also GeorgiaFIRST Marketplace users.  Users returned by 
this query are limited to any user assigned one of the “BOR_CAT” roles.  
The values returned for each user include: 

• User ID and Name 
• Employment Status  & other Job Action related data 
• User’s Security Status (Unlocked or Locked)   

Action is required by Security Admins for all inactive GFM users with a 
status of “Unlocked” including: 

• Locking PeopleSoft accounts 
• Setting GFM Profiles associated with these User IDs as “Inactive” 

within the GeorgiaFIRST Marketplace (currently handled by the 
GFM Security Administrator / ITS SUPPORT) 
 

GENERAL LEDGER (GL) / COMMITMENT CONTROL (KK) 

MODIFICATIONS TO EXISTING BOR PROCESSES AND REPORTS 

BORRG044 
Grant Budget Progress 
Report (Basic Detail) 

BOR Menus > BOR General Ledger > BOR GL Reports > Grant 
Budget Progress Report 

The field for Account description on the Grant Budget Progress Report 
(BORRG044, Basic Detail Level) has been truncated so that it no longer 
prints over the text in the subsequent field. 
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PAGE CHANGES 

MCR95-New BOR Track 
Project Grant tab 

Setup Financials/Supply Chain > Common Definitions > Design 
Chartfields > Define Values > Chartfield Values > Project > Project ID 
 
A new tab has been added to the Project/Grant setup page.  This tab is 
called BOR Track Project Grant and is located between the BOR Project 
Info Tab and the BOR Project Financials Tab.  This tab allows for 
additional grant information to be entered, such as: is the grant direct, is the 
grant a pass thru, does the grant include a loan portion, is the grantor non-
profit, are institution matching funds involved, field of study for research 
grants, etc.  The values in these new fields will be populated in the 
TRCK_PRJGRT_BOR table. Users are able to query this table to retrieve 
the needed values for reporting purposes. 
 

“Private” value added 
back to Funding Type 
Options for Projects 

Setup Financials/Supply Chain > Common Definitions > Design 
Chartfields > Define Values > Chartfield Values > Project > Project ID 
> BOR Project Info Tab 
 
Prior to the upgrade to PeopleSoft Financials 8.9, “Private” was listed as an 
option under the Funding Type field for projects.  “Private” was no longer 
an option that users could choose from in PeopleSoft Financials 8.9, but it 
has now been added back in as a Funding Type Option for all projects. 

PURCHASING (PO) 

MODIFICATIONS TO EXISTING BOR PROCESSES AND REPORTS 

Minority Vendor Report 
(BORRP008.rpt) 

 

BOR Menus > BOR Purchasing > BOR PO Reports > Minority 
Vendor Report 

This report is a custom Crystal report that provides spend data for vendors 
assigned minority vendor types.   

Modifications were made to the order in which parameter fields are pulled 
from the associated query on to this Crystal report. The variables, Business 
Unit and Fiscal Year, were restructured within the query in order to pass 
data from the query to the report correctly.  Now, when this report is run, 
the fields are formatted correctly and data populates as expected.   

This modification/fix resolves Known Issue KI8140. 

QUERIES 

BOR_MIN_VEND_ 
EXCLU_GOV2 

Reporting Tools > Query > Query Manager 

The BOR_MIN_VEND_EXCLU_GOV2 query was modified to use a 
newly created view (BOR_VNDR_TYP_VW) instead of pulling directly 
from the vendor type table.  

This modification was necessary to prevent duplication of voucher amounts 
based on the number of lines pulled directly from the vendor type table.  
This correction ensures that the monetary amount for each voucher is 
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summed and reported correctly.    

SECURITY (SC) 

MODIFICATIONS TO EXISTING BOR PROCESSES AND REPORTS 

User Access Report 
(BORRS001) 

The User access report was modified to correct issues with Multi Campus 
users appearing on the old campuses report.  The User ID of a multi-
campus user should only appear on the active campuses report. 

QUERIES 

BOR_SEC_ 
TERMINTED_USERS  

 

The Terminated Users Query was modified to add Retirees, Deceased and 
Suspended employee statuses.  This Query will be modified again in 
release 2.31 to correct a B business unit issue. 

 

BOR_PORTAL_ 
PERMISSIONS 

 

A new query was developed to assist local security administrators in 
determining the page names that a role has access to.  In the past, queries 
would show the menu name and component name, which is sometimes 
hard to track back to a functional name.  This query shows the Portal Label 
name, and it is run by Role Name for the Prompt field.  

SEGREGATE_DUTY_ 
BOR 

This is a very important query with which security administrators on 
campus should become familiar.  This query uses the Segregation of Duties 
Matrix that was provided by the auditors and displays users that have 
potential or real segregation of duties issues.  The results on this query will 
need to be reviewed, and administrators need to have the appropriate 
reasons documented and signed off on for the auditors.   

A job aid for this query is available on the GeorgiaFIRST website at 
http://www.usg.edu/gafirst-fin/documentation/job_aids/category/security  

TRAVEL & EXPENSES (EX) 

QUERIES 

BOR_EX_DUE  
 

The BOR_EX_DUE Query was modified to add the Payment Method field 
so that the EFT or CHK will be visible. 

WORKFLOW 

NEW BOR PROCESSES AND REPORTS 

Human Resources User 
List 
(ITS use only) 

This new user list was created for Workflow Configuration purposes.  This 
will allow an institution using ePro to route transactions to a Human 
Resources Approval Path upon request.  ITS will have to configure 

http://www.usg.edu/gafirst-fin/documentation/job_aids/category/security
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workflow for each institution that request this path. 

OTHER NOTES 
Next Scheduled 
Release 

PeopleSoft Financials Release 2.40 is currently scheduled for May 19, 
2012.  You will receive a reminder of when this update will occur. 

More Information and 
Support 

For business impact emergency issues, contact the ITS Helpdesk 
immediately at 706-583-2001 or 1-888-875-3697 (toll free within Georgia).  
For non-urgent issues, contact the ITS Helpdesk via the self-service support 
website at http://www.usg.edu/customer_services.  (This service requires a 
user ID and password.  E-mail helpdesk@usg.edu to obtain self-service 
login credentials.) 

Additional Resources For more information about ITS maintenance schedules or Service Level 
Guidelines, please visit http://www.usg.edu/oiit/policies.  

 

http://www.usg.edu/customer_services
mailto:helpdesk@usg.edu
http://www.usg.edu/oiit/policies
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